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WELCOME TO COMICBASE!

Thank you for purchasing ComicBase, the world’s #1 software for 
managing comic collections! ComicBase is both a professional tool for 
organizing and managing your collection, as well as a comprehensive 
comic book reference. It includes a comic book price guide of comic 
values over the past four years, comics reviews, an encyclopedia of comic 
books with detailed notes on over 225,000 issues, and thousands of full-
color illustrations of cover art. 

ComicBase will give you information on what each title is about, tell 
you how it relates to other titles, and help you find special issues by first 
appearances, origin stories, writer, or artist. It will keep track of which 
comics you have, chart your collection’s value over time, and print a 
wide variety of reports that let you manage your collection like a pro. Use 
ComicBase to create price labels, detailed price lists, collection statistics, 
and checklists, or to research and buy comics online.  

We’ve combined our research with that of Comics Buyer’s Guide to cover 
more titles, both mainstream and independent, than any other guide. 
We’ve also expanded our pricing research to include sales at retail stores, 
conventions and online auction sites. The result is the most realistic, hard-
hitting price guide available. 

ComicBase is available in two versions: a CD Standard Edition, and 
the amazing Archive Edition on two DVD-ROMs containing expanded 
database content, over 20,000 full-sized, high-definition cover images, as 
well as over 70,000 comic covers, and dozens of additional interviews and 
movie previews.

WHAT YOU SHOULD KNOW 
BEFORE USING THIS GUIDE
This user’s guide assumes you know the basics of using your computer. For 
example, you should know how to:

• Use the mouse and keyboard

• Know how to click and drag with your mouse

• Choose from a menu

• Copy files and disks

If you are unsure how to perform these tasks, consult the User’s Guide 
which came with your computer. 

INSTALLING COMICBASE
1. Exit any Windows programs you are running. This is important: 

running programs can prevent ComicBase from installing 
properly.

A PRIMER ON COMICBASE 
TERMINOLOGY

Below is a list of words frequently 
used in this manual.

Title is the name of a comic book se-
ries. Action Comics is a title. Within 
this title, there have been over 700 
issues.

Issue is a single installment of a 
title, usually with its own number. 
Examples are Action Comics #23 or 
The Amazing Spider-Man #42.

Comic is a generic term for a comic 
book. For instance, if you have two 
copies of The Amazing Spider-Man 
#42, and one copy of Bone #1, you 
have three comics.

Cost is the price you paid for comic.

Value is what our research says is the 
current market value for an issue in a 
certain condition.

Price is the amount you wish an 
issue to sell for.
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2. Insert the ComicBase Program Disk. The ComicBase launcher 
program will start automatically (double-click the Launcher.exe 
file if autostart is disabled on your computer).

3. The InstallShield Wizard will guide you through the installation 
process.

4. Install QuickTime (used for viewing movies). Note: The 
QuickTime installer will ask for a serial number—unless 
you’ve previously bought QuickTime Pro from Apple, leave this 
blank.

5. Install Adobe Reader (used for viewing documentation)

6. Launch ComicBase by double-clicking its icon on your desktop, 
or choosing it from your Start Menu. 

     The first time you run ComicBase, it will ask if you’re upgrading 
from a previous version. If you are, click Yes, then follow the 
instructions onscreen to transfer your collection data from your 
old version of ComicBase.

7. If you’ve got sufficient free hard disk space (400 MB or more), 
use the File Menu’s Manage Pictures command to install 
pictures and movies from the ComicBase Program Disk (and 
any bonus disks) to your hard drive. Otherwise, you’ll need to 
have the ComicBase disk in your drive when you want to see 
pictures and movies.

LAUNCHING COMICBASE
The first time you launch ComicBase, you will be asked to enter your 
name, your company’s name (if applicable), and the unique serial number 
for your copy of ComicBase. You will find your serial number inside the 
ComicBase case and on your registration card.

REGISTERING 
You must register your copy of ComicBase in order to receive:

• Technical support

• Advance notification of upgrades

• Special prices on upgrades

Register by sending in the registration card which came with ComicBase, 
or using the Internet menu’s Register ComicBase Online command. 

TECHNICAL SUPPORT
Many questions about how to use ComicBase are covered in this manual. 
Additional program updates and bug fixes are available for free online. You 
can download these automatically by using the Internet menu’s Check 
for Program Updates command.
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If you have questions that are not answered in this manual, or a problem 
that cannot be solved by the latest update, or you have suggestions for 
improvements or changes you’d like to see in ComicBase, you can reach 
us during our regular business hours (M-F from 10a.m. to 5p.m. PST) at
408/266-6883. You can also contact us at any time via e-mail to: 
support@human-computing.com, or fax us at 408/266-5869.

When calling for technical support, please have your registration number 
handy for the quickest assistance.
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COMICBASE BASICS

The following few pages will cover everything you need to know to get 
started with ComicBase, including how to move between titles, look up 
prices and issue details, find special comics, and more.

In the next section, we’ll get into detail about how to track your own 
collection in ComicBase. But, for now, let’s take a moment, and get 
familiar with the main ComicBase window. 
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1.  Cover Thumbnail 

Shows a thumbnail preview of the selected comic’s cover. If no 
image is available, then a publisher or default logo will be displayed 
instead.
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2.  Current Title

Displays full name of the series you are viewing.

3.  Title Abbreviation 

Abbreviated title name assigned by ComicBase.

4.  Publisher Name & Years Published

Name of the publisher, as well as the years during which this title was 
published. 

5.  Title Genres 

Icons designating the genres (e.g. Horror, Comedy) that this title 
features. (For a full list of genres and their descriptions, see page 22.)

6.  Movie Button   

Plays an interview clip or movie trailer, if one is associated with this 
title. See the entry Hellblazer for an example.

7.  Find Comics Button  

Allows you to search for comics by various criteria. 

8.  Move To Previous, Next Title Buttons 

To view the next title in alphabetical order, click the right arrow. To 
view the previous title, click the left arrow. Right click on either to 
bring up a list of more options.

9.  Choose Title Button 

Opens the Title List which allows you to go quickly to any title in the 
database.

10.  Title Description

A brief write-up telling you what this title is about.

11.  Issue Selection Column

Click in this column to select issues. Information on the fi rst issue 
selected will be brought up and displayed. (Select discontiguous issues 
by holding down the Ctrl key while clicking on all the issues you wish 
to select. You can also hold down Shift while clicking to highlight all 
comics within a range.)

A value graph will appear on the right and issue notes will replace the 
review and publisher information. The graph shows the issue’s value 
for the past four years.

12.  Cover Picture Icon   

Shows whether or not a cover picture is available for this issue. Small 
image icons are red and blue, while high-defi nition, large image icons 
have a green plus sign over the icon. Pausing over a picture icon will 
automatically display the image. If a larger picture is available, pausing 
longer will zoom it to full size.

13.  Mark Issue Column

You can use this column to note comics that are special to you in some 
way—e.g. they have sentimental value, or you want to remind yourself 
to purchase them.

Helpful Shortcuts

Ctrl + T        Title List

>                   Next Title

<                   Previous Title    
  
Ctrl + F        Find

 TIP
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14. Issue Number

The number of this issue.

15. Issue Condition & Other Fields

The fi elds to the right of the picture icons contain information on 
writers, artists, storylines, pricing, and various other information about 
an issue. There are also custom fi elds available for you to enter your 
own categories. (See Managing Your Collection for more information 
on how to do this.)

Pricing changes for an issue of a comic are denoted in the Issue Fields, 
with prices in red indicating an increase in value and prices in blue 
indicating a decrese in an issue’s worth.

You can edit any of the fi elds by double clicking on the specifi c cell 
you want to change. 

Right-clicking on any fi eld in will also bring up a list of options for 
managing your individual comic issues—such adding a new issue, 
deleting an issue you don’t want, or using the internet to search for 
that issue to buy. These options are also available through the Comics 
fi le menu.

You can change or resize by dragging the column headers. You can 
even shrink a column up to nothing to hide it. (Right click and choose 
Show Hidden Columns to unhide.)

TITLES
Titles in ComicBase are listed by alphabetical order, and can be accessed 
by using the navigation buttons in the main window, or much more quickly 
through the Title List. The fastest way to fi nd titles in the Title List is to type 
in the fi rst few letters of the name of the title you wish to see. 

Moving from One Title to the Next
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If you are having trouble fi nding a series you want, try typing in just the 
name. Titles that start with “An” or “The” are indexed with the article at 
the end. (Thus, The Amazing Spider-Man is actually listed as “Amazing 
Spider-Man, The”.

If that doesn’t work, try a title search using the Find command.

FINDING COMICS
The Find command can be used to search for titles or issues of comics 
matching various criteria. This can range from all the titles with “spider” 
in the name, or issues in your collection worth more than $50. It also has 
several special searches that let you locate a character’s fi rst appearance, 
death, origin stories, and more.

To fi nd issues, click the Find Comics icon in your ComicBase main 
window. You can restrict any search to just the titles you own by checking 
the List Only Issues in Stock checkbox at the bottom.

USING FIND TO SEARCH

Begin by selecting the type of thing you’re looking for from the Find 
dropdown list at the top. 

Many searches show an indexed list, which you can move through by 
quickly typing the fi rst few letters of your search. For instance, if you’re 
looking for the fi rst appearance of Psylocke, you only have to type “psyl” 
in the 1st Appearance fi nd box.

When ComicBase fi nds the items that match what you’re looking for, it will 
bring up a list of those items. The list will remain onscreen until you close it, 
so you can view other issues or titles that matched your search criteria.

SEARCH CATEGORIES

To fi nd issues or titles, click the Find button and select what you want to 
search for. The list is of things you can fi nd broken up into three parts.

The fi rst set of search es looks for in for ma tion from the Notes, Storyline, 
Artist, and Writer fi elds.

•  FIRST AP PEAR ANCE fi nds the fi rst time a char ac ter ap peared in any 
title.

•  SECOND AP PEAR ANCE fi nds the sec ond time a char ac ter ap peared 
in any title.
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•  ORIGIN finds stories which tell how super-heroes (or villains) 
came by their powers, or found their calling. Origin stories are 
often repeated for popular characters, and sometimes revised 
for long-running characters.

•  DEATH finds stories in which a character dies. (Whether he/she/
it remained dead is another matter…)

•  STORYLINE/CROSSOVER finds stories. It’s particularly useful for 
finding crossover stories that run through several issues and, 
sometimes, through several titles.

•  ARTIST finds the issues which were drawn by a particular artist or 
penciller.

•  WRITER finds issues which were written by a certain writer.

•  NOTES searches the notes field for anything else that might be 
special about an issue, such as a costume change, a wedding, 
or information you’ve added, such as place where you bought 
it. When entering what you’re looking for, be as general as 
possible. For instance, if you’re looking for the issue in which 
Spider-Man donned a new costume, type in “costume” or “new 
costume.”

The next set of searches finds titles, rather than issues. 

•  DESCRIPTION DATE MODIFIED finds titles by the date you changed 
(or created) the titles’ descriptions in ComicBase.

•  GENRE finds titles by which genre have been checked in the Title 
Detail window. If you check more than one genre checkbox, 
this search will only find titles that also have all those 
checkboxes checked. You can also search on custom genres 
you’ve created. 

•  MATURE READERS ONLY finds any titles that have the Mature 
Readers Only checkbox checked. 

•  TITLE DATE CREATED finds titles by the date they were added 
to your ComicBase. This search is particularly useful if you’re 
adding titles and want a list of the titles you’ve recently added.

•  TITLE DATE MODIFIED finds titles by the date they were modified 
in ComicBase. 

•  TITLE NAME lets you search for a title by any word within its 
name.

•  PUBLISHER helps you find all the titles from a certain publisher.

•  TITLE DESCRIPTION finds a title by words in its ComicBase 
description, such as “vampire” or “spoof.”

•  TITLE COMMENTS let you find a title by comments in the  title 
comments window.

•  TITLE MARKED finds titles which have the Marked checkbox 
checked.

The next group of searches find items based on issue information.

•  QUANTITY IN STOCK finds issues in your collection by how many 
copies you have. For instance, if you want to find all the issues 
for which you own more than 2 copies, so you can sell off your 
overstock, you can use this search.

USING MULTIPLE 
SEARCHES

Looking for something very specific?  
Whether you’re looking to widen the  
range of comics fitting your search  
criteria or hunt down a particular 
issue from a certain time period 
and publisher, if you’re looking for 
a comic title or issue that falls under 
more than one search category, you 
may need to do multiple searches to 
find what you want.

Click the Find Comics button again 
while the Found Comics list is still 
onscreen to use successive searches 
to narrow or widen previous search 
results. This allows you to do com-
plex searches, such as finding “All 
the Marvel Comics published after 
1953 and before 1960.” To narrow 
searches, just select the Narrow 
Results option. To widen searches, 
choose “Append to Results” in the 
Find dialog box.

Note that some searches (such as 
searching for a Publisher) will bring 
back a list of titles; others (such as 
searching for Quantity in Stock) 
bring back lists of issues. ComicBase 
will automatically do the right thing 
in this regard without requiring you 
to explicitly choose the table. 

Occasionally, however, you may 
want to do a complex search which 
involves both title fields and issue 
fields. The type of data in the list 
will always correspond to the last 
type of search chosen. For instance, 
if you want to see a list of issues 
from Dark Horse comics which you 
have more than one of copy of, first 
search by “Publisher is Dark Horse”, 
followed by a narrowing search for 
“Quantity in Stock is greater than 1.” 
If you wanted to see a list of titles 
from Dark Horse for which you have 
more than one copy, do the Quan-
tity in stock search first, followed by 
the Publisher search.
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OTHER USES FOR FIND

You can Mark, Unmark, and 
Quick Change the issues you’ve 
found. Simply highlight the issues 
in the Found Comics list that you 
want to work with, and choose 
the appropriate commands from 
the Edit menu. This lets you do 
unique operations such as finding 
all Sabretooth appearances and 
marking them as “Wanted”. See the 
Managing Your Collection chapter 
for more information on using the 
Mark, Unmark, and Quick Change 
commands.

•  CONDITION finds comics by the condition they’re in, such as all 
your comics in very fine (VF) condition.

•  COVER PRICE finds comics by their original cover price. For 
instance, you can use it to find all the comics you own 
which had a 75¢ cover price. Note that ComicBase does not 
include cover price for every issue; you may need to add this 
information yourself.

•  COVER DATE finds comics by their cover date. Since some titles, 
like 2000 A.D., are published weekly, we use a month/day/year 
format. For instance, you can use it to create a list of issues 
published in March 1999 by entering 3/1/1999. Note that not 
every issue in ComicBase has cover date filled; you may need 
to add this information yourself.

•   PRICE finds comics in your collection by your selling price, such 
as all comics priced more than $50 each.

•  COST finds comics in your collection by your cost, such as all  
comics you bought for less than $1 each.

•   CURRENT VALUE finds comics in your collection by their current 
value, for instance, all comics worth more than $100 each.

•   (YEAR) VALUE finds comics in your collection by their value in a 
particular year. For instance, you can find all the comics that 
were worth $2.95 in 1996.

•   DATE MODIFIED lets you search for comics by the date they were 
modified in your ComicBase. For instance, you could use this 
to find a list of all the comics you logged into your collection 
yesterday.

•   MARKED lets you find any issues with the Marked checkbox 
checked.

ComicBase also includes several custom fields that you can use for 
anything you wish. The custom fields will appear in the Find menu with 
the names you’ve given them. You can use them to search for information 
in the custom fields just as with similar fields. 

HYPERTEXT LINKS
Move between related titles and learn more about the world of comic 
books with ComicBase’s hypertext links. If you click on any highlighted 
word in a ComicBase description, the program will take you to the related 
title. For example, in the description for Wolverine, the words “Uncanny 
X-Men” are highlighted in blue. When you click on the highlighted text, 
ComicBase will algorithmically find the matching title. 

INTERNET LINKS
Various features in ComicBase also connect you to comic information on 
the web. To make use of these features, you have to be properly configured 
for internet access. See the instructions that came with your computer for 
help in doing this.

If a publisher has a web site, then the name of the publisher will be 
underlined in the Title Description. Click on the name to link to the 
publisher’s web page. If there is no link for a publisher, but you know 
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the publisher’s URL, you can create an internet link for it using the Setup 
menu’s Publishers command. 

The Internet menu also has links to the ComicBase home page, the online 
registration form, and the ComicBase updates page. Remember, you must 
register your copy in order to receive technical support, advanced notice of 
upgrades, and special prices on upgrades!

You can also use commands in the Internet menu to shop for comics on 
online auction sites, or to research a comic’s recent selling prices. 

JUMP TO ISSUE
To jump to an issue directly from a long list of issues, choose the Edit 
Menu’s Jump to Issue… command (or press the Ctrl key and hit J). This 
will bring  up a small dialog where you can type in the issue number you 
want to see. This is especially useful for finding issues under long-running 
titles such as Action Comics or 2000 A.D. 
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MANAGING YOUR
COLLECTION

Because ComicBase comes built-in with information on over 225,000 
issues, it makes tracking your own collection very simple and effi cient—
instead of having to fi ll in all the details of an issue yourself, most of what 
you’ll be doing is just changing one or two fi elds in the data that is already 
there. (For instance, changing the quantity in stock from zero to one to 
indicate that you have an issue.)

ComicBase offers a variety of ways to modify issues, depending on your 
particular needs:

• The Fastest Way to Enter an Issue: To mark that you have one or 
more issues in stock, just highlight them in the Issues List and press 
the 1 key on your keyboard to indicate that you have one copy 
in stock (pressing 2 indicates that you have two copies in stock, 
etc.)

• Entering Data Directly Into the Issues List: This is useful for mak-
ing quick edits to any fi eld, such as to change a cost or price for an 
issue.

• Using Quick Change: to set the value of a given fi eld for one or 
more issues (such as to indicate that you paid $1 for issues 312-
338 of Captain America). 

• Double-Clicking on an Issue to Edit Its Detail: This lets you 
change all the information on an issue on a single screen.

ENTERING DATA DIRECTLY INTO THE ISSUES LIST

Most information about an issue can be changed just by double-clicking 
on its fi eld in the Issues List and typing the new information. There are a 
few tricks, however, to make this even easier. 

You can resize the fi eld widths by clicking and dragging their boundary 
line to the desired width. If you don’t want to see a given fi eld, you can 
even drag its width up to nothing, hiding it. (Right-clicking in the column 
in the Issue List header will display these fi elds again.)

You can change the order in which the Issues List fi elds are displayed by 
clicking on a fi eld and dragging to the left or right. 

QUICK CHANGE

Use the Edit menu’s Quick Change command to quickly modify a single 
fi eld for many selected issues—for instance, if you’d like to quickly change 
the selling price of Spawn issues #1-50 to $3.00. Just select the issues 
you want and choose the Edit menu’s Quick Change command. (You 
can select a discontiguous range of issues by pressing the Ctrl key while 
selecting.) 

AMAZE YOUR FRIENDS! 
ENTER YOUR ISSUES WITH 
A SINGLE KEYSTROKE!

The quickest way to enter any-
thing in ComicBase is to select the 
issue and hit a number between 
1-9 to indicate the quantity that 
you own. ComicBase will add 
that value to the Quantity fi eld 
for all issues selected.

For instance, if you had a copy of 
Amazing Spider-Man #129, you 
could simply select that issue, 
then change its quantity from 
zero to one to indicate that you 
own it. 

 TIP
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You can also use Quick Change to modify comics you’ve found using the 
Find Comics command. This is particularly useful if, for instance, you want 
to search the entire database for comics by Neal Adams, then mark them 
as “wanted.” After doing a Find Comics, just select the issues you want to 
change from the Found Comics list, then choose Quick Change from the 
Edit menu.

The Quick Change dialog will appear:

 Choose the fi eld you’d like to modify, enter a value, then click Save to 
change that value for all the issues you’ve selected. 

Note that if you use Quick Change to add information in the Notes fi eld 
for a range of issues, ComicBase will append your notes to any in for ma tion 
that may be in the Notes fi eld already.

You can add a new issue with all the information of the existing issues too. 
This is most useful when you have two copies of the same issue in different 
con di tions, or when you’re adding an issue that has mostly (or exactly) the 
same information as a previous issue).

MODIFYING AN ISSUE’S DETAIL
If you’d like to see all the information about an issue at once, or perhaps 
want to change several pieces of information about an issue—such as its 
grade, price, notes, etc..—you can simply double-click on the issue, and 
you will be presented with the comic’s Issue Detail screen. 
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COMIC TYPE

In addition to the regular monthly issues of a comic title, publishers 
sometimes release special comics such as annuals or holiday specials. 
ComicBase lets you enter these by choosing the appropriate comic 
type from the Comic Types dropdown menu. ComicBase lists numerous 
special types of comics, from trade paperbacks to special editions to 3-D 
and ashcan releases, and even swimsuit issues and giant-size specials. 
Moreover, you can add your own comic types to the dropdown menu 
through the Setup menu under Comic Types.

ISSUE NUMBER 

This is the issue’s number which generally appears on the cover or in the 
tiny fine print on the inside first page (the comic’s “indicia”).

ISSUE VARIATIONS 

It has become an especially popular trend amongst publishers to print 
many variant covers for comics, in particular first issues (check out the 14 
variant covers of Gen 13 #1). If such a case arises, you will want to identify 
the specific variant that you own. 

ComicBase lists most types of issue variations, including variant covers, 
gold, platinum, and silver editions, autographed copies, and more. You can 
add a variation to the variations dropdown menu by going to the Setup 
menu and choosing Issue Variations.

PRINTINGS

Some popular comics are re-released in a second printing (or third, fourth, 
etc. These later printings are usually worth less than the first printing. If you 
have a comic that was part of a later printing, the Printing dropdown menu 
on the far right lets you select which printing it was. 

COVER PRICE AND VALUES

ComicBase will also fill in the values and cover price based on the 
previous issue, so using the same example above, Excalibur (2nd Series) 
#2 will have the same default cover price, writer, and artist as #1.

GRADING CONDITION

Select the comic’s condition from the Condition dropdown menu. 
Most undamaged, new comics are in what is known as near mint (NM) 
condition. 

If you’re unsure of the comic’s grade, you can use ComicBase’s Grading 
Wizard to help you evaluate the comic. Simply click the question mark 
icon to the right of the Condition dropdown and the Grading Wizard 
will appear. Select the appropriate choices which describe your comic’s 
appearance and the Wizard will give you an estimated grade for the comic, 
according to accepted industry standards.

When the condition is changed, ComicBase will automatically update the 
selling price field to match the guide value for this issue.

QUANTITY

The Quantity field lists the number of issues you have of this comic. 

COST

Type the amount you paid for each comic in the Cost field.
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ComicBase will automatically calculate the value for a single copy based 
on its condition in the Selling Price field. If you would like to sell your 
copies for a higher or lower price, you can override the value and type in 
the price you think is appropriate in the Selling Price field. This is the price 
that will appear on price labels and price lists.

NOTES

Enter any special information not handled by the other fields into the Notes 
field. This may include a special character appearance, or reasons for the 
issue’s grade. This information can appear on the issue’s price label and in 
some reports. Use semicolons (;) to separate multiple annotations for the 
same issue, or put each on a separate line in the Notes field. For example, 
if you were adding Asterix Bk 1 and wanted to note that it included the first 
appearances of Asterix and Obelix and gives an explanation of Obelix’s 
strength, you would write “1st appearance Asterix; 1st appearance Obelix; 
Origin Obelix.” 

STORYLINES

The Storylines field lists the names of the stories that ran in this issue. This 
is particularly helpful for letting you locate reprinted stories, or for finding 
the different issues that comprise a multipart storyline such as Knightfall. If 
an issue has multiple storylines, put each story on a separate line.

WRITER AND ARTIST

Use the Writer and Artist fields to enter in the writer and penciller for a 
particular issue. (ComicBase does not track inkers or colorists, but you 
can add them to the Artist field or create your own field to track them.) 
The information here will appear on price labels, in price lists, and in 
writer and artist searches. If you want to list more than one writer or artist 
for a given issue, separate each person’s name with a comma (e.g. “Neil 
Gaiman, Alan Moore.”)

MARKING ISSUES

Sometimes, it’s useful to designate issues that are important to you in some 
way: for instance, comics you have up for auction, or comics which should 
be stored separately due to their high value. Whatever the need, you can 
quickly flag such comics using the Mark and Unmark commands. 

Marked comics appear with a check mark next to them in the Issues View, 
and you can also use the Find Comics command to quickly get a list of any 
marked comics.

To mark one or more issues, select the issues you’d like to modify from 
the Issues View, Modify Issues, or Found Comics list. You can select a 
discontiguous range of issues by pressing the Ctrl key while selecting 
issues. Then, choose the Edit menu’s Mark command to mark the issues.

To unmark issues, follow the same procedure to select the issues, then use 
the Edit menu’s Unmark command.

CUSTOM FIELDS

ComicBase’s Custom fields can be used for any special purposes you may 
have. Some ComicBase users have been known to have a field to keep 
track of a comic’s location (e.g. “Box 11”).  Others like having a field to 
indicate where (or from whose collection) a comic was purchased. Still 
others want to have separate checkboxes to mark issues they want to buy 
as well as comics they want to sell. Data entered in these custom fields can 

KEY WORDS FOR USE IN
THE NOTES FIELD

ComicBase looks for certain  key-
words when it searches for special is-
sues. When you add notes with these 
phrases, the entries are automatically 
added to the appropriate list in the 
Find Comics window.

ORIGIN or ORIGIN OF for origin stories

    Example: Origin Spider-Man

DEATH or DEATH OF for death stories

    Example: Death of Superman
    
1ST APPEARANCE or 1ST APPEARANCE OF 

    Example: 1st appearance Dazzler

2ND APPEARANCE or 2ND APPEARANCE OF 

    Example: 2nd appearance Cable

APPEARANCE for special appearances
 
    Example: Lobo appearance
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be automatically searched with the Find Comics command, and printed 
on reports.

To name a custom field, checkbox, or date field, use the Setup menu’s 
Custom Fields command.

DUPLICATING AN ISSUE
If you’d like to add a new issue which is a duplicate of an existing one (e.g., 
a second copy of a comic in a different condition), select that issue and 
choose the Edit menu’s Duplicate command. (Or, simply right click on the 
selection and choose Duplicate from the option list.) 

The Issue Detail for the duplicated issue will appear. You can change the 
issue number, condition, and any other field just as if you were modifying 
the original issue.

ADDING NEW ISSUES
As new comics are released, you’ll want to add them to your copy of 
ComicBase. To do this, go to the comic title in question and choose the 
Comic menu’s New Issue comics command (Ctrl + N).

By default, the issue number shown when adding new issues will be the 
next regular issue in the sequence for the selected title. Thus, if you choose 
to add a new issue after Excalibur (2nd Series) #1, published in July 2004, 
ComicBase will add #2 as the next issue, and automatically record it as 
published in August 2004. 

You can set a different issue number by typing in the Number field; if 
you’re adding a range of issues, enter the first issue in the Number field 
and the last issue in the Through field. Any information you enter, such as 
condition, cost, and notes will be entered for all issues in the range.

REMOVING ISSUES
ComicBase has information on thousands of issues, but as you’ll notice, the 
quantity of each is originally set to 0 (indicating you don’t have any copies 
of the issues in your collection). Most of the time, you’ll want to leave the 
issue information in ComicBase because it’s useful for finding a special 
appearance, artist/writer’s work, or any other issue specifics. Keep in mind 
that you can restrict the list to just issues you own, so that you won’t need 
to remove all issues permanently just to get a report of your collection. 

However, you can also permanently remove issue listings in ComicBase. 
Simply select the issues you want to remove, then right click and choose 
Delete. You can also remove an issue through the Issue Detail window by 
clicking on the Remove button at the bottom.
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ADDING NEW TITLES
 Whenever you buy a newly released title, or fi nd an old title that we’ve 
some how over looked, you’ll want to add it to your ComicBase database. 
To add a new title, go to the Title List and click on New.    

NAMING TITLES

Be aware that the proper title is not always the same as the name on the 
cover—in fact, it can be fi endishly diffi cult to determine the proper name 
for a title. See “The Black Art of Title Naming” (sidebar).

If a title begins with “The” or “A” or “An” put any one of that word at the 
end of the title, separated by a comma. For in stance, if you were adding 
The Vig i lan te, you would enter it as “Vig i lan te, The” in the Name fi eld. 
This way, ComicBase will list the title in al pha bet i cal order under “V” 
(Vig i lan te) rather than “T” (The). If the title contains both an article and a 
colon, such as The Trouble With Girls: The Night of the Lizard, then move 
the article right before the colon and write the rest as it appears. Thus, the 
correct naming is “Trouble With Girls, The: The Night of the Lizard.”

PUBLISHER

Next, select the title’s publisher from the Publisher menu. If the pub lish er’s 
name doesn’t appear on the list, type in the name of the publisher and 
hit Enter. A dropdown window will appear that will allow you to enter 
in the publisher’s information. If you have a lot of titles from a particular 
publisher not in the Publisher menu, you may wish to add the publisher 
to your list of publishers so that it appears the next time you add a title. 
Otherwise, uncheck the  Add to List of Publishers box at the bottom of the 
dropdown.

COPYRIGHT

You can type in the copyright information in the Copyright fi eld. Usually, 
you’ll fi nd this in for ma tion in the indicia of a title (see sidebar). 

 THE BLACK ART OF 
TITLE NAMING

Any title you add must have a unique 
name, but fi nding the right name can be 
surprisingly diffi cult, what with misleading 
cover titles, erroneous and missing volume 
numbers, and multiple titles with the same 
name.

THE INDICIA

To deal with all this, it’s helpful to follow 
certain naming con ven tions so that your 
name for a new title will match the name 
we use when re leas ing price up grades. In 
adding titles to Comic Base, we gen er al ly 
give titles the same name as is listed in the 
comic’s indicia. The indicia is usually a tiny 
paragraph of fi ne print at the bottom of the 
fi rst page or last page of the comic. It con-
tains the title of the comic, copyright,  and 
various publication information.

The real problem comes when mul ti ple 
titles have the same name listed in their 
indicia. In that case, we add on one of the 
fol low ing comments to the title name (in 
de scend ing order of preference):

• LIMITED SERIES, MINI-SERIES—Cloak & Dag-
ger (Ltd. Series) and Nightwing (Mini-Se-
ries). Marvel titles of limited duration are 
generally known as “limited series.” Other 
companies tend to call theirs “mini-series.” 
We use the appropriate abbreviation when-
 ev er we can to dif fer en ti ate a regular title 
from a short-run title from the same pub-
lisher by the same name.

• VOLUME NUMBER—Strange Tales (Vol. 1) 
and Strange Tales (Vol. 2). This is used 
when the same publisher has published 
the title at different times with dif fer ent 
volume numbers. It’s the way the whole 
naming convention should work, but it falls 
apart when either the publisher changes the 
volume number multiple times during the 
same run, or they refer to several different 
runs as “Vol. 1” in the indicia. In those 
cases, we try…

• PUBLISHER NAME—Tarzan (Marvel) and Tar-
zan (DC). This is used when more than one 
company published a single series with the 
same name.

• SERIES NUMBER—Aquaman (1st Series) 
through Aquaman (6th Series). This is used 
in desperation when nothing else works, 
usually because there were multiple mini-
series, the volume numbers were inappro-
priate, or there were multiple pub lish ers—
at least one of which ran multiple series by 
the same name.
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GENRE DEFINITIONS

Action/Adventure—Any title with 
action-oriented stories, usually in 
contemporary settings. Ex. Young 
Indiana Jones, Punisher

Adult—Titles with content (explicit 
sex, drug use, or extreme violence) 
that would earn it an NC-17 rating. 
Ex. Carnal Comics

ANTHOLOGY—A title with several un-
connected stories by various artists 
and writers in each issue. Ex. 2000 
A.D.

ANTHROPOMORPHIC—Titles whose 
characters are animals acting like 
humans. Ex. Albedo, Porky Pig

COMEDY—Titles with lightweight 
stories, humorous characters, and 
happy endings. Ex. The Simpsons

CRIME—Titles that feature gang-
sters, gunplay, and commissions 
of crimes. Emphasis is on plot-
ting, commission, and aftermath 
of crimes. Ex. Police Action, Crime 
Detective Comics

DRAMA—A focus on emotion and 
interpersonal conflict. Ex. Slacker 
Comics

FANTASY—Titles with stories in imag-
ined settings and with mythical or 
folkloric heroes. Ex. Elfquest, Conan 
the Barbarian

HORROR—Titles featuring frightening 
characters, such as monsters and 
vampires. Ex. Buffy the Vampire 
Slayer, Tomb of Dracula

LICENSED—Comics with characters or 
stories originally released in another 
medium, such as book or movie. Ex. 
Terminator, Pokémon

MANGA/ANIME—Titles with stories 
and art in the style of Japanese com-
ics or animated films. Ex. Bubblegum 
Crisis, Ninja High School

YEARS PUBLISHED

The following line asks for the years a title was published in the Years 
Published field. This information will appear in the title’s description 
window. When adding years, separate year ranges with commas or 
hyphens to differentiate between different publishing years and consecutive 
publication years. E.g.  “1979, 1985” or “1983-1988, 1999-Present” 

TITLE URL AND COMMENTS

ComicBase also provides spaces for adding title URL, title comments, and 
checkboxes for genre identifiers, which you can customize to add your 
own. If you enter a title URL here, the user can go directly to that title’s web 
page by clicking on the title name in the description window. 

You can enter title comments in the Title Comments field. ComicBase 
occasionally uses this field to note a publisher name change during a 
series’ run, but you can use it to keep any notes you wish.

GENRE

Below the Title Comments field is a number of checkboxes to denote 
the genres this title belongs to. For instance, if you were adding a title 
about some zany astronaut rabbits, you might check “Anthropomorphic,” 
“Comedy,” and “Science Fiction.” (See the sidebar for genre definitions). 

Icons for the checked genres will appear in the Title Description window. 
You can also go to the Setup menu and use the Custom Fields command 
to add your own genres. You can also search for titles by their genres, 
including custom genres.

MATURE TITLES

The Mature Readers Only box is for titles which deal with themes you 
believe are not appropriate for younger readers. Any title with this box 
checked will be removed if you go into the File menu’s File Tools and 
choose Remove Mature Readers Titles. 

MARKING TITLES

The Comic Title dialog also lets you mark a title so that you can find it 
easily by your own criteria. There’s a Marked checkbox, and three custom 
title checkboxes that you can use for your own special purposes (e.g. 
“Black and White”, “Hot Title”, “Sell it”, etc.) using the Setup menu’s 
Custom Fields menu item.

MODIFYING TITLES
To modify titles in ComicBase, open the Title List, highlight the title you 
wish to change, and click the Modify button at the bottom of the title list to 
modify that entry. This will bring up the Title Detail box.  
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EDITING TITLE DESCRIPTIONS
The space below the picture box will generally contain a review for the 
series you are viewing. We’ve worked hard with the guys over at Comic 
Buyers Guide to bring you the most comprehensive encyclopedia of 
comics reviews available to date. But if you find any entry with no review, 
or you wish to add to the review, you can easily change the text by going 
to the Comics menu and choosing Edit Title Description. When a Done 
Editing button appears above the text field in the description window, you 
can begin editing the description, or add in a new one. If your description 
is too large for the description box, ComicBase will automatically add a 
scroll bar that lets you scroll through the description. Click Done Editing to 
close the editing window. 

BOLD, ITALICS, AND UNDERLINING

The Style and Font menus on the main menu bar are only activated when 
you use the Edit Title Descriptions command.

You can make words in your title description appear bold, italicized, 
underlined, or as hypertext by making use of the Style commands from the 
main menu bar. Simply highlight the text you wish changed and select the 
command you want from the menu. 

You can also change the font size of the description by using the Style 
menu bar. You can alter the type of font displayed by going to the Font 
menu and selecting the font you want to use.

CREATING HYPERTEXT LINKS 

ComicBase lets you link words in your description to other titles through 
a Hypertext command. To do so, highlight the name of the other title in 
your description and choose Hypertext from the Style menu. The selected 
text will be changed to blue. Now, whenever you click the highlighted 
words, ComicBase will jump to the next sequential title beginning with 
those words.

REMOVING TITLES
Removing a title from ComicBase removes all of its information. If you 
want to retrieve the information, say, because you started collecting issues 
of a title that you’ve removed, you will have to reinstall ComicBase. (Of 
course, you can always enter in the information yourself.) If you only want 
to restrict a list to the issues or titles you own, it’s safer just to click the Titles 
in Stock button in the Titles list.

To remove titles permanently from your collection, first open the Title List, 
and in the dialog box that appears, select the title you want to remove. 
Then, click Remove. 

CONTINUED…

MYSTERY—Titles in which the char-
acters solve a mystery, or work out 
an enigma. Ex. Sherlock Holmes, 
Scooby Doo

NON-FICTION—Titles dealing with 
events or occurrences that are (al-
legedly) true. Ex. Who Really Killed 
JFK, Real Life Comics

PIN-UPS/ART BOOK—Books consisting 
primarily of comic art alone—not a 
story. Ex. Fathom Swimsuit Special, 
Hot Shots: X-Men

RELIGIOUS—Titles involving religious 
characters or themes. Ex. Life of Pope 
John Paul II, The Brick Testament

ROMANCE—Titles with stories focus-
ing on love or emotional attraction. 
Ex. Young Romance, Our Love

SCIENCE FICTION—Speculative fic-
tion with a scientific factor, such 
as aliens, time travel, or robots. Ex. 
Sigil, Timecop

SPORTS—Titles about  sports, athlet-
ics, or sports characters. Ex. NASCAR 
Adventures, Champion Sports

SUPER-HEROES—Titles featuring char-
acters with extraordinary powers 
and abilities, often wearing cos-
tumes. Ex. Superman, Spider-Man

UNDERGROUND—Small-print-run titles 
with a decidedly non-mainstream 
feel, often dealing with topics 
such as sex, and drugs. Ex. Hup, 
Anomaly

WAR—Titles about war and com-
bat. Ex. Battlefield Action, Frontline 
Combat

WESTERN—Titles set in the late 19th 
century western United States. Usu-
ally involves cowboys and Indians. 
Ex. Tomahawk, The Rawhide Kid 
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MANAGING MORE THAN ONE 
COLLECTION
You and your son/friend/roommate/boyfriend/girlfriend can now keep 
your collections separate in ComicBase. To do this, choose the File menu’s 
New Database command and create a new file. You can then switch 
between the different databases by using the File menu’s Open Database 
command.

It’s also a good idea to choose different colored backgrounds to keep track 
of your separate collections. You can change the color of a databases main 
window by using the File menu’s Window Color command.

BACKING UP YOUR COPY OF COMICBASE 
Since your ComicBase contains important information about your 
collection, we recommend keeping at least one backup copy of your data. 
This will preserve the work you’ve done should anything (such as a crash 
while writing to disk) corrupt your active copy of ComicBase. 

By default, ComicBase will keep your backup copy of ComicBase in your 
ComicBase folder on your hard drive. If you want to keep your backup in 
another location, click Change Location, and specify where you want your 
back-up copy stored. 

To protect your data in case of hard drive failure, we also recommend 
periodically transferring a copy of your database onto a CD or DVD, or 
creating a backup copy on a remote hard drive or removable media. 

To do so, select the File menu’s Save a Copy command. You can save your 
ComicBase onto any hard drive or onto removable media. The file will be 
called “Copy of ComicBase.cba”

If you only have a floppy disk, you can back up your data only by using 
the File menu’s Export Price List command. (The ComicBase database is 
too large to fit on a floppy disk.) This will export only the issue information 
you’ve entered, which will fit on a floppy disk as a text file. This backup, 
however, will not include information such as: covers you’ve scanned in, 
descriptions you’ve modified, or custom grading and other custom fields.

RESTORING FROM A BACKUP
These instructions assume you have a full backup (created by ComicBase’s 
automatic back-up or with the Save a Copy command). If you saved your 
data as a price list onto a floppy disk, follow instructions for importing data 
into ComicBase (see Transferring Data).

To restore your data into ComicBase, you cannot be running ComicBase. 
Quit the program if it is running.

First, change the name of your backup database (usually named “Copy of 
ComicBase Database.cba”) to “ComicBase Database.cba”. Copy it into 
ComicBase’s “Program Data” folder. By default, ComicBase is installed in 
C:/Program Files/Human Computing/ComicBase 9. If asked whether you’d 
like to replace the existing ComicBase Database.cba file, click Yes.

Then, go to the Start menu and select ComicBase from your Programs 
menu to launch ComicBase.  
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ComicBase should run as normal from whatever information was saved in 
the backup copy. It is recommended that you create another backup copy  
as soon as possible.

CHECKING FOR PROGRAM UPDATES
ComicBase can check the Human Computing site regularly for any 
program updates, which include bug fixes. You can check for updates 
yourself at any time by using the Internet menu’s Check for Program 
Updates command.

You can also set the program to check for updates every time the program 
launches, once a day, once a week, once a month, or never. Go under the 
Setup menu and select Preferences, then identify the frequency you’d 
like the program to check for updates. If you don’t have internet access, or 
prefer to check for updates manually, select Never.
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PRINTING AND REPORTS

ComicBase can generate a variety of reports and labels, including price 
lists, price labels, and inventory reports for managing your collection. This 
chapter describes the various statistics and labels you will be able to print. 
You can see a preview of any report before you print it by clicking the 
Preview button in ComicBase’s Print window. 

COMICBASE STATISTICS
You can ask ComicBase to report different kinds of information about your 
collection, such as:

• The cost and value of your collection

• The number of titles and comics you own

• Your potential profi t (mark-up) if you were to sell your 
collection at its current value

To view statistics about your collection, go to the File menu, select 
ComicBase Statistics, and click the Calculate button. 

In the window that appears, you can check off which statistics you want.

Checking the “Collection value statistics” will simply calculate the value, 
asking price, cost, and mark-up (maximum profi t value) of your collection. 
If you check “Include breakdown by publisher”, the report will list how 
many titles and comics you own by publisher, and present the cost, value, 
and asking price of your collection subtotaled by publisher.

Checking Titles With Missing Descriptions” or Titles With Missing Pictures 
will let you know if (and how many) titles you have missing descriptions 
and pictures, respectively. These checks considerably lengthen the time for 
the Statistics Report to process, as they require the program to check every 
title in ComicBase. 
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Once the statistics have been calculated, you can preview the printout by 
hitting the Preview button, or print the statistics by directly by clicking 
Print.

PRINTING PRICE LABELS
You can use ComicBase to create price labels for each of your comics, or 
just for comics you own from specifi c titles. Each price label will show the 
comic’s title and issue number, condition, price, and notes. The labels will 
also show writer and artist credits unless you uncheck those listings in the 
Issue Listings box in Preferences (found under the Setup menu).

The labels also include a code (such as the 5X317 shown on this label) that 
tells you when the label was printed. The fi rst number in the code indicates 
the month the issue was entered into inventory (i.e. 5 for May), followed by 
an X, the day of the month the label was printed (i.e. 31 for the 31st day), 
and the last digit of the year the label was printed (i.e. 7 for 1997).

To print price labels for your comics, follow these steps:

1. Go to the File menu and select the Print command. In the 
dialog box that appears, choose the Price Labels icon from the 
top bar.
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2. Select the type of price label you are going to use from the 
Label dropdown menu. ComicBase will automatically resize 
the price label text to fit the label size you select.           

3. Select the titles and issues you want to print labels for.

a. To print price labels for all the comics in your collection, 
click the All radio button.

b.  To print price labels for all the comics you own, but only 
for certain titles, click the Selected Titles radio button. A 
dialog box will appear which lists the titles in ComicBase.  
Select the titles for which you want price labels printed. 
Hold down Ctrl to select more than one title. (Moving 
between parts of the list will not deselect your selections).

c. To print price labels for specific issues, click the Selected 
Issues radio button. The Issue Selection dialog box will 
appear. Click Add to select a title, then select issues from 
that title for which you want labels printed.

 If you want to add issues from another title to the list, click 
Add in the Issue Selection dialog box. Continue adding 
issues, title by title, until you have a complete list of the 
specific issues for which you want price labels. If you 
accidentally select an issue or issues for which you don’t 
want labels, select the issues and choose Remove.

 By default, ComicBase will assume you want to print 
a price label for each comic of an issue you own. For 
instance, if you own two copies of Spawn #11, ComicBase 
will print a label for each copy. If you want to change the 
number of labels per issue that ComicBase prints, select the 
issue (or issues) in the Issue Selection dialog box and click 
Copies. Change the number in the box that appears to the 
number of price labels you would like ComicBase to print, 
then click OK.

4.  You can check the Only Print If New or Price Changed box 
print labels only for comics that have been added recently, or 
have had their price change recently. This feature is especially 
useful if you regularly print price labels for your comics.

5.  If you’d like the labels to include storylines, check the Include 
Storylines checkbox.

6.  In the Print dialog box, select the first available label on your 
first sheet of labels.

7. Click the Print button to start printing labels.
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PRINTING PRICE LISTS
ComicBase can print price lists showing the issues in your collection. 
These reports are particularly useful for creating a list of comics for sale.

To create a price list:

1. Go to the File menu and select the Print command. Choose the 
Price List icon (or select Price List from the Report menu).

2. If you want the report to include only comics you own, check 
off the box marked List Only Issues in Stock. If you want the 
report to include information on the issues’ storylines, check 
off the box marked Include Storylines. If you want your reports 
to show your cost as well as the issues’ values, check the box 
marked Include Cost.

3.  You can also include information from any of your custom 
fi elds. Just check the fi elds you want included in the Custom 
Fields to Include box. Note: this will add another line for the 
information for each issue, effectively doubling the length of 
your report. 

4.  If you want a price list for all the comics in ComicBase, make 
sure the All radio button is fi lled in. Check the List only issues in 
stock checkbox to limit the list to comics you own. Otherwise, 
you will end up with a report that runs for thousands of pages.

5.  If you want a price list for only one title, or only for selected 
titles, click the radio button next to Selected Titles. A list of all 
the titles in ComicBase will appear. You can narrow the list to 
just the titles you own by clicking Titles in Stock. 

 Select the titles you want included in the report. Use the arrows 
at the lower left hand corner to view the fi rst, second, and third 
part of this list. Hold down the Ctrl key to select more than one 
title. (Moving between parts of the list will not deselect your 
selections). Click OK when you’ve selected all the titles you 
want to include.
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 You can also create a selection that’s the result of a search by 
clicking the Find button. 

6.  Choose between Basic, Summary, or Detailed radio boxes in 
the Report Type box.

 BASIC price list shows you the number of copies you own of an 
issue and each comic’s condition, value, and/or cost. This list 
totals the value of your collection by title.

 SUMMARY price list shows the value and number of copies of 
each title in your collection, and, if you’re including it, cost.

 DETAILED price list shows the number of copies you own of an 
issue and each comic’s condition and value, and, if you’re 
including it, cost. It also shows the value of each comic over 
the previous three years. This report is generally printed in 
landscape (wide) orientation.

7. Click the Print button to print your price list.

PRINTING ISSUE CHECKLISTS
ComicBase lets you print issue checklists that show you the issues you 
own and/or the issues you want and their near-mint value and notes about 
them. For issues you own, it will also tell you how many copies you have, 
what condition the copies are in, their value, and how much you paid for 
each copy. These reports are particularly useful for taking to a convention 
or store to effectively build the collection you want.

To create an issue checklist:

1. From the File menu, select the Print command and click the 
Issue Checklists icon (or go to the Report menu and choose 
Issue Checklists).
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2. Check off what you’d like the report to include in the Report 
Items box. If you check Issues of each title, the report will list 
all the issues you own. If you check Missing Issues for each title, 
the report will list issues you don’t own.

 You can also include information in your custom fields by 
checking the field names in the Custom Fields to Include 
box. Adding these fields will add an extra line to the report 
for each issue (even for issues which don’t have custom field 
information).

3. To include every title in ComicBase, check the All radio button. 
To create a report that only includes a title, or certain titles, 
click the Selected Titles radio button. 

 You can also create a selection that’s the result of a search by 
clicking Find while selecting titles. (See page 30).

 You can also narrow the list to just the titles you own by clicking 
Titles in Stock. Hold down the Ctrl key  to select more than one 
title. (Moving between parts of the list will not deselect your 
selections). Click OK” when you’ve selected all the titles you 
want to include.

4.  Check Include Storylines to include storylines along with the 
report information.

5. Click the Print button to print your Issue Checklists report.

PRINTING TITLE REPORTS
You can use ComicBase’s title reports to create a hard-copy record of 
the comics you own and their totaled worth. Title reports are particularly 
useful for insurance or for auctioning off large blocks of your collection 
(or evaluating a lot of comics up for sale). A title report may include which 
issues you own, and/or which issues you don’t own, of all titles, or of 
selected titles.

To print title reports:

1.  Go to the File menu to select the Print command and click the 
Title Report icon in the dialog box to select it (or choose Title 
Report from the Report menu). 

2. Check off what you’d like the report to include in the Report 
Items box. If you check Issues of each title, the report will list all 
the issues of all the titles you’re including. If you check Missing 
Issues, the report will list issues you don’t own.

 You can also include information in your custom fields by 
checking the field names in the Custom Fields to include 
box. Adding these fields will add an extra line to the report 
for each issue (even for issues which don’t have custom field 
information).

3.  To include every title in ComicBase, check the All radio button. 
To create a report that only includes a title, or certain titles, 
click the Selected Titles radio button. 

 You can also create a selection that’s the result of a search by 
clicking the Find button while selecting titles. 
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    Narrow the list to just the titles you own by clicking Titles 
in Stock. Hold down the Ctrl key  to select more than one 
title. (Moving between parts of the list will not deselect your 
selections). Click OK when you’ve selected all the titles you 
want to include.

4. Title reports, by default, will list each issue individually, so you 
can mark them off. If you prefer a shorter report, you can list a 
contiguous range of issues as a group (e.g. Action Comics #488-
490, 493-497, 501) by checking the Group Issue Numbers 
Together box.

5. Click the Print button to print your Title report.

PRINTING DIVIDER LABELS
If you have an extensive collection, you may be using dividers to separate 
your titles. These dividers are available from most comic book dealers.

With ComicBase, you can print labels for the tabs on your dividers. 

To print divider labels:

1. Choose Divider Labels from the Report menu, or go to the File
menu and choose Print.

2. Click the Divider Labels icon to select it.

3. If the All radio button is fi lled, ComicBase will print divider 
labels for all the titles in ComicBase.

4.  To print divider labels for only certain titles, click the Selected 
Titles radio button. A list of all the titles in ComicBase will 
appear. 
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 You can also create a selection that’s the result of a search by 
clicking the Find button while selecting titles. 

 You can also narrow the list to just the titles you own by clicking 
Titles in Stock. Hold down the Ctrl key while clicking to select 
more than one title. (Moving between parts of the list will not 
deselect your selections). Click OK when you’ve selected all 
the titles you want to include. 

5.  Use the Label Type dropdown menu to select the label size 
on which you’ll be printing your labels. ComicBase will also 
automatically size the text to fit your label.

6.  Click the Print Labels for Both Sides box if you want to print two 
labels for each title—one label for each side of the divider.

7.  Click on the position of the first available label on the first label 
sheet, and click the Print button to start printing.

PRINTING DESCRIPTIONS
You can print the descriptions for each title onto labels that you can affix to 
your title dividers. This is very helpful for prospective buyers who want to 
learn more about the titles in your collection before a purchase.

To print divider blurbs

1.  Go to the File menu and select Print (or choose Divider Blurbs 
from the Report menu).

2.  Click the Divider Blurbs icon to select it. You may need to use 
the scroll bar to scroll down to the second row of icons.

3.  If the All radio button is filled, ComicBase will print divider 
blurbs for all the titles in ComicBase.

4.  To print divider blurbs for only titles you own, or only for 
certain titles, click the Selected Titles radio button. A list of all 
the titles you own in ComicBase will appear. 

 You can also create a selection that’s the result of a search by 
clicking the Find button while selecting titles. (See page 30).

 You can also narrow the list to just the titles you own by 
clicking the Titles in Stock button. Hold down the Ctrl key 
while clicking to select more than one title. (Moving between 
parts of the list will not deselect your selections). Click OK 
when you’ve selected all the titles you want to include). 

5.  Use the Label dropdown menu to select the label size on which 
you’ll be printing your labels. ComicBase will shrink the font 
size down to fit the description on any size label.

6.  Check the Print Labels for Both Sides box if you want to print 
two blurbs for each title—one description for each side of the 
divider.

7.  Click on the position of the first available label on the first label 
sheet, and click the Print button to start printing.



COMICBASE 9 USER GUIDE TRANSFERRING DATA

34

COMICBASE 9 USER GUIDE TRANSFERRING DATA

35

TRANSFERRING DATA 

ComicBase includes a variety of functions for importing and exporting 
data to help you organize and manage your collections. The import and 
export functions lets you exchange data with most major spreadsheets and 
databases, such as FileMaker or Microsoft Excel.

Likewise, you can export information from ComicBase for use in Excel and 
Filemaker, etc., to graph the value of your collection, or place your data 
into a page-layout program.

ComicBase also allows you to transfer your collection data into your Palm 
or Pocket PC computer so that you can reference your collection status 
quickly when away from home (such as when browsing at conventions). 

IMPORTING INFORMATION 
FROM OTHER PROGRAMS
You can use the File menu’s Import Price List command to import 
information from another program, such as a database or spreadsheet:

1.  Export your information from the database or spreadsheet 
to a tab-delimited text file. If you’re not sure how to export 
information from the database or spreadsheet, review your 
documentation for that program. You will need to export 
information for at least four fields: title, issue number, condition, 
and quantity. 

2. From the File menu, selevt Import. In the dialog box that 
appears, locate the exported file on your hard disk.

3.  When you click Open, the Import Price List dialog box will 
appear.

4.  Move fields that match your exported files to the Import Fields 
box using Move. For instance, if you have fields for title, 
issue number, condition, cost, and value in your database or 
spreadsheet, you would move the fields Comic Title, Issue 
Number, Condition, Cost, and Selling Price.

5.  Use the dropdown menus to select how items and records are 
separated (by tab, return, or space) in the exported file.

6.  The order of fields in the Import Fields dialog box should match 
the order of fields in your database or spreadsheet. 

7.  Radio buttons at the bottom of the Import Price List dialog box 
let you choose how you want your information to integrate with 
the information already in ComicBase.
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 Replace All Issues of Imported Titles is faster, but it will over write 
all issue in for ma tion in ComicBase. Only use this option if you 
want to replace all the in for ma tion in ComicBase.

 The more common option, Replace Only Matching or New 
Issues is slower, but it will only overwrite the issues being 
imported. 

8. Some spread sheet or da ta base programs create an initial “mail 
merge” header that lists the names of the fi elds. This can be 
useful if you want to match up ComicBase fi elds with the fi elds 
you’re using, but if you try to import the header, you will get an 
error message in ComicBase telling you something like there 
is no title named Comic Title. You can skip past the header by 
typing in how many Lines to Skip at Be gin ning.

9.  Click Show Preview to see how your fi elds will match up with 
Comic Base fi elds. Always use Show Preview to make sure 
your data will be imported into the correct fi eld. Most of the 
prob lems with im port ing are the result of im port ing data into 
the wrong fi elds.

10. After importing your information into ComicBase, look at the 
Issue View and the Issue Detail for the titles for which you’ve 
imported information, and check that your in for ma tion has 
been imported into the right fi elds.

EXPORTING DATA
You may fi nd it use ful to move in for ma tion from ComicBase to another 
program, such as a page-layout pro gram to create a private catalog, or to a 
web authoring pro gram for posting your list online.

To export information from ComicBase:

1. From the File menu, select the Export command .

2. In the Export Price List dialog box, move all the fi elds you want 
to export from the Avail able Fields list to the Export Fields 
list. Add blank fi elds for special fi elds for which there are no 
ComicBase equiv a lents. For ex am ple, if you were im port ing 
your data into an Excel spread sheet with col umns for Title, 
Issue Number, Penciller , and Inker, you would use Comic Title, 
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Issue Number, and Artist from the Available Fields list and click 
Add Blank to have information flow in correctly.

3. ComicBase can export text using a variety of item and record 
separators. Use the Item Separator and Record Separator 
dropdown fields to select the correct format. The most common 
format is tab-delimited text, for which you can select Tab for the 
item separator and Return for the record separator.

4. Use the Style dropdown menu to select how you want the 
information exported. If you’ll be importing the exported data 
into a spreadsheet or database, select Spreadsheet-Database 
records. Spreadsheet-Database export lists the title name on 
each line, like this:

  2000 A.D., 129, 1, NM, 3.75, Judge Dredd

  2000 A.D., 133, 1, NM, 3.75, Judge Dredd

  2000 A.D., 134, 1, NM, 3.75, Judge Dredd 

 If you’ll be exporting the data and opening it with your word 
processor, say, for a custom report, select “Formatted Report. 
Report Format.” It shows the title name once per title:

         2000 A.D.  

             129       1           NM 3.75 Judge Dredd

  133 1 NM 3.75 Judge Dredd

  134 1 NM 3.75 Judge Dredd

5.  If you want the report to include only issues in your collection, 
check the Export Only Issues in Stock Box.

6.  If you want the exported information to include all the titles in 
ComicBase, click the All radio button. If you want the exported 
information to only include specific titles, click the Selected 
Titles radio button. 

 Click Titles in Stock to see a list of the titles for which you own 
comics. You can also click the Find button to find titles you 
want to export, say, all titles which are marked.

 Select the titles for which you want information exported. Hold 
down the Ctrl key while clicking to select more than one 
title. (Moving between parts of the list will not deselect your 
selections). Click OK when you’ve selected all the titles you 
want to export.

7. If you want the exported information to include field titles 
(i.e. Comic Title, Issue Number) check the Include Field Titles 
box. Having field titles included in your report is handy if the 
spreadsheet or database you’re exporting the information to has 
a preview feature, or if you’re creating a custom report.

8. Click OK to create a ComicBase export file. Give the export 
file a name and specify where you want it saved. Be sure to 
remember the name you’ve given the file and the location you 
saved it, so you’ll be able to find it when you’re ready to import 
or open the exported information.
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EXPORTING LISTS TO HANDHELD COMPUTERS
Price lists, issue checklists, and title reports can be exported as text or 
HTML files by clicking Export in the Print dialog. You can also transfer 
exported reports to your Palm or Pocket PC computer, allowing you to 
check your collection status easily—especially if you are adding to your 
collection while on the road or shopping at a convention.

Although you can certainly use your Palm/Pocket PC synchronization 
tools to load in the raw, exported text, it’s far more legible (and 
compact) if you first convert the file into “book” form. There are many
converters/readers available, but we are particularly fond of the ones made 
by iSilo (http://www.isilo.com), and have bundled the shareware versions 
of their converters with ComicBase.

To convert a file to book form using iSilo, do the following:

1. Export the desired report by clicking the Print dialog’s Export 
button. Exporting it to your Desktop makes it easy to find later.

 Note: The Title Report (with grouped issues) is generally the 
most useful of all the reports, due to its compact format and 
diminutive size. It lets you quickly see what issues you have 
and which are missing for a given title—usually the most 
important information.

 Issue Checklists and Price lists can also be useful, but you 
should be careful to not overwhelm the (generally tiny) 
processor of your handheld with too much data.

2. Launch iSiloX for your preferred platform (Palm or Pocket PC).

3. From the Document menu, choose Add. You’ll be prompted 
for a name for the book (e.g. “Title Report - Roger Durham”)

4. Choose Add URL/File to add the file you’ve just exported to the 
list of files to be converted into book form. Select the exported 
report file you created in step #1.

5. On Palm computers, you will also have the option of choosing 
the user name which you can automatically HotSync this file 
to. Choose your user name, then click Done.

6. Click Convert All to create your book. If you’ve chosen a 
HotSync destination in step #5, your book will be automatically 
loaded onto your Palm/Pocket PC when you do your next 
HotSync. Otherwise, load it onto your handheld computer 
using your handheld’s file transfer tools.

7. You can view the book from your handheld using the 
iSilo reader application (which you should install on your 
handheld). A freeware version is available for the Palm, and a 
more powerful (and quite cheap) shareware version exists for 
both Palm and Pocket PC computers. 
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IMAGES AND MOVIES

ADDING NEW ARTWORK
ComicBase 9 now allows you to scan in comics at whatever size you like, 
and the program will automatically size pictures to fit your available screen 
space. 

To add an image file to ComicBase, it has to be saved and named by its 
issue number in the proper location on your hard drive. Save the image as 
a JPEG file and be sure to save your image to the correct image folder. 

For instance, if you were saving a cover scan of CrossGen’s Ruse #1, you 
would save it to the following folder:

 [Your ComicBase Pictures & Movies Folder]

 (See Manage Pictures and Movies)

  Pictures

   C

    CrossGen

     Ruse

You would name the image “1” because it is issue #1. When you go to that 
title in ComicBase, an image icon will appear in the picture icon box next 
to the issue number. 

Due to the huge number of comics they’ve published, you need to add 
another level to this folder hierarchy when saving scans of titles published 
by Marvel, DC, Dark Horse, and Image. Specifically, an extra folder with 
the first letter of the title should be inserted after the publisher name. Cover 
art for an issue of DC’s Four Star Spectacular, for instance, is saved in:

 [Your ComicBase Pictures & Movies Folder]

       (See Manage Pictures and Movies)

  Pictures

   D

    DC

     F

      Four Star Spectacular



COMICBASE 9 USER GUIDE IMAGES AND MOVIES

38

COMICBASE 9 USER GUIDE IMAGES AND MOVIES

39

Finally, be sure to not use any special characters which are prohibited by 
your file system. Characters you will need to replace include “?”, “*”,”\”, 
“:” and “...” If any of these characters appear in the title name, use a “-” 
character instead. For instance, if the title is Whodunnit?, you name its 
folder “Whodunnit-”.

Better yet, let ComicBase make the folder for you. When adding or 
modifying a title in ComicBase, just check Create Picture Folder before you 
save the title. ComicBase will automatically determine the proper folder 
hierarchy for pictures of this title, and create it if it didn’t previously exist.

ADDING NEW MOVIES
If you have enough hard drive space, you can also add QuickTime-format 
movie clips to ComicBase. To add your clips to ComicBase:

1. If there isn’t a Movies folder in the ComicBase folder on your 
hard drive, create one.

2. Give the movie a name that exactly matches the name of the 
title as it appears in ComicBase, and append the file extension 
.mov to the name. Replace any colons or commas with dashes. 
If you’re using Windows, also replace any periods or slashes in 
the name with dashes. For instance, if you create a movie for 
Bubblegum Crisis: Grand Mal, name the image “Bubblegum 
Crisis- Grand Mal.mov.”

3. Save the movie into the Movies folder in the ComicBase folder 
on your hard drive.  The corresponding title should have a 
movie icon in its Picture view which lets you play the movie.

 [Your ComicBase Pictures & Movies Folder]

  (See Manage Pictures and Movies)

   Movies

   

Check to make sure that you have Qucktime installed on your computer 
before attempting to play your movie files. A free version of the program is 
available for download at http://www.apple.com/quicktime/products/qt/
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ADVANCED COMICBASE

MODIFYING ISSUE VARIATIONS
The Variations dropdown menu in the Issue Detail is set up for most types 
of issue variations, including gold, platinum, and silver editions, special 
covers, special sets and editions, such as a collector’s set or a deluxe 
edition. You can also use it to specify an issue you’ve had autographed. 

The following will show you how to add, change, or remove items from the 
list of issue variations.

ADDING AN ISSUE VARIATION

1. Under the Setup menu, select Issue Vari a tions.

2. In the Issue Vari a tions Setup box, click New.

3. Type the name of the new issue variation into the Issue Variation 
fi eld.

4. Move to the Ab bre vi a tion fi eld and type in an ab bre vi a tion, up 
to four characters long, for the issue variation. This will appear 
next to the issue number in the Issues window.

5. Click Save to save the new issue variation. It will be available in 
the Variation dropdown menu in the Issue Detail window.

To change the name or abbreviation for an issue variation, select it in 
the list and change the name or ab bre vi a tion in the Issue Vari a tion and 
Abbreviation text boxes. Click Save. The new name and/or ab bre vi a tion 
will appear in the Vari a tions dropdown menu, but will not change the 
previous ab bre vi a tion used for com ics already indexed in ComicBase.
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MODIFYING COMIC TYPES
The Comic Types dropdown menu lets you specify if you have a special 
comic such as a 3-D special, annual, ashcan preview, or year book. You 
can add, remove, or change these comic types.

ADD A NEW COMIC TYPE:

1. Go to the Setup menu and select Comic Types.

2. In the Comic Types Setup box, click New. Type the name of the 
new comic type in the Comic Type fi eld.

3. In the Abbreviation fi eld, enter a 2- or 3-letter ab bre vi a tion for 
the comic type. This ab bre vi a tion will appear next to the issue 
number in the title’s Issues window.

4. Click Save to save the new comic type. You will now be able 
to select it in the Comic Types dropdown menu in the Issue 
Detail.

REMOVE A COMIC TYPE:

1. Go to the Setup menu and select Comic Types.

2. Select the comic type you want to remove and click the 
Remove.

3. Click Save to save the changes. The comic type you removed 
will no longer be avail able in the Comic Types dropdown menu 
in the Issue Detail.

To change the name or abbreviation for a comic type, select it in the list 
and change the name or abbreviation in the Comic Type and Abbreviation 
fi elds. Click Save. The new name and/or abbreviation will appear in the 
Comic Types dropdown menu and the Issues Views, but will not change 
the previous abbreviation used for comics already indexed in ComicBase.

MODIFYING PUBLISHERS
The Pub lish ers dropdown menu in the Is sue Detail win dow lets you choose 
from the most common pub lish ers. If your publisher is not in the list, type 
in the name of that pub lish er anyway, and when you move to edit another 
fi eld in the Issue Detail window, a window will dropdown asking you for 
the publisher’s information. If you have a lot of com ics from a pub lish er not 
in the Publishers dropdown list, you may wish to add that pub lish er to the 
Pub lish er dropdown menu. Just check the Add to List of Publishers box at 
the bottom of the window.
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Another way to add a pub lish er is to select the Set up menu’s Pub lish ers 
com mand. 

Type the name of the publisher into the Pub lish er Name box. ComicBase 
au to mat i cal ly enters the publisher’s name into the Copy right fi eld. If 
a person or com pa ny other than the title’s publisher typically owns 
the copyright to the title you’re adding, type in the name of the proper 
copyright holder. This is the in for ma tion that will appear in the copy right 
title whenever you add a title from this pub lish er.

If you know it, enter the publisher’s web site address (URL) into 
the Publisher’s Home Page box. You must write the address in full, 
i.e. http://www.darkhorse.com.

Click Save to add the publisher to ComicBase and exit the window. The 
publisher you’ve added will now appear in all Pub lish er dropdown menus 
in ComicBase.

To change a pub lish er’s in for ma tion, select the Setup menu’s Publishers 
command, and select the publisher whose in for ma tion you want to 
change. You can overwrite or add information, such as web site address, to 
the publisher’s fi elds. Click Save to save your changes.

To remove a pub lish er, select the Setup menu’s Publisher com mand. 
In the dropdown menu, select the publisher you want to remove. Click 
Remove. The pub lish er you removed will no longer be available from 
Publisher dropdown menus in ComicBase.

NOTE: removing a publisher from the Publishers dropdown menu will not 
remove that pub lish er’s titles from ComicBase. It will only remove the 
publisher name from the Publisher dropdown menus.

MODIFYING PRICING YEARS
ComicBase keeps track of four periods (years) of pricing in for ma tion for 
each issue. This lets you get a historical perspective on each issue’s value 
history.

When you install a ComicBase pricing update, the program will 
automatically modify the pricing years for you.

You can change the periods used to keep track of your com ics’ val ue 
your self. This is useful if you want to track pricing data, say, quar ter ly, or 
by de cades, and you have pric ing in for ma tion you can import or add for 
those periods. Note: any periods you choose will apply to all the issues in 
ComicBase.
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To modify the periods, go to the Setup menu and select Pricing Years. 
Choose one of the years and type in the name of the new period, up to 4 
characters in length. For instance, if you want to keep track of prices on a 
quarterly basis, you might replace 2004 with Q1.

When you close the window, ComicBase will replace the year with the 
new pricing period in the Issue Detail, value history graphs, and reports.

Until you replace ComicBase’s pricing information with your own, the 
information for each period will be the same as for the last four years. 
ComicBase only supports four time periods at once. If you want to add a 
new time period, you must first close out another time period.

To close out a period, such as the oldest year, choose the period on the list 
and click the Close Year. Before ComicBase closes out a period, it gives you 
the option of saving a copy of ComicBase with the closed out year’s prices 
in it. If you don’t save a copy, you will lose all the pricing information in 
the closed year (or time period).

To add a period, click New Year and name the new period.

USING FIND AND REPLACE
ComicBase includes the ability to Find and Replace text information across 
the entire database. This works like the Find and Replace function in a 
word processor, and is particularly useful when you want to standardize 
the spelling of artist names, change the names of publishers, or even 
change the spelling of condition names (e.g. changing NrMt to NM). 

To find an replace text, go to the Edit menu and choose Find and Replace. 
Enter the text you’d like to search for, and choose which field to look in.  
Keep in mind that since Find and Replace works only on text information, 
it cannot search date or check box fields. 

MASS CHANGE
Although it’s used only rarely, the Mass Change command is useful for 
making changes throughout ComicBase. For instance, you can use it to 
set the price of every issue in ComicBase to the previous year’s values, or 
check the Marked box for every issue of several titles at once.

To use the Mass Change command, select it from the Comics menu. In 
the dialog box that appears, select the field you want to change in the 
Change dropdown menu. This will offer you a choice of the value and date 
fields.

The Mass Change command can apply to all the titles in ComicBase, or 
only to selected titles. To apply changes to a select list of titles, click the 
Selected Titles radio button and in the window that appears, select the titles 
to which you want to apply changes.

A NOTE FOR USING
FIND & REPLACE

If you change the contents of the 
notes, storylines, artist, or writer 
fields, you may cause the lists of 
artists, writers, etc. that ComicBase 
displays as choices when you do a 
Find Comics to become outdated.

It’s a good idea to periodically have 
ComicBase rebuild these lists if you 
do replacements in these fields.  To 
do this, choose the File menu’s File 
Tools option, select Rebuild List of 
Titles, then check the Find Comics 
Lists when asked which items to 
rebuild. This process will likely 
take several minutes to complete 
(which is why it’s not done for you 
automatically whenever you Find 
and Replace!).
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Click the Field radio button to replace the values in one fi eld with the 
values of another fi eld. For instance, you can change the selling price of all 
issues to be the same as the cover price—or some mathematical variation 
thereof. 

You might also, for example, want to offer certain titles at half price. To do 
this, choose to Mass Change the Price to the Year 4 [2002] Value * 0.5.  (i.e. 
50% of the current guide value). If you choose, you can also round any 
math e mat i cal values au to mat i cal ly (so that, for in stance, you don’t wind 
up selling a 1.75 book for 87.5 cents at your 1/2-off sale.

 Click the Value radio button to set the chosen fi eld to a special value. For 
instance, you might select titles you want to sell quickly and change the 
selling price for all the issues of those titles to $0.25.

When you’ve entered the values or dates you want changed, click the 
Make Changes button.

FILE TOOLS
Under the File menu is a command for the File Tools window, which gives 
you access to a variety of tools for stream lining ComicBase, making it run 
faster, converting Comic Base’s values to your local cur ren cy, and fi xing 
minor program prob lems.

COMPACT AND VERIFY COMICBASE

Compacting ComicBase will prompt the program to verify the integrity 
of the database and free up any unused space. You can set the conditions 
for how frequently ComicBase will compact its information by selecting 
the option you want in Preferences. To start this operation yourself, go 
to the File menu, and under File Tools, choose Compact and Verify 
ComicBase.

REBUILD LISTS

Like most databases, ComicBase does not physically reconstruct itself each 
time a record is changed. Instead, it marks the old information as unused. 
This unused space can build up over time, and take up unnecessary 
space on your hard disk. Com pact ing ComicBase frees unused space in 
ComicBase and verifi es the integrity of your data.

When you click the Compact & Verify ComicBase button, you will get 
a dialog box that tells you how much space you’ll save if you com pact 
ComicBase. Click the OK button to start com pact ing. The process may take 
several minutes.

The Rebuild Lists button rebuilds lists and indices in ComicBase. 
Comic Base checks to make sure its list of titles is correctly matched with 
the pictures and data from each. If you fi nd that ComicBase is not match ing 
pictures or data correctly to titles, this command will rebuild the list of 
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titles in stock, the Find comics lists, issue in for ma tion, and title names and 
descriptions.

When you click the Rebuild Lists button, the following dialog will appear:

Checking Ti tle Information re builds Comic Base’s internal title and 
descriptions index. It’s useful if ComicBase isn’t taking you to the title 
you’ve selected—i.e. you entered “Abe Sapien” in the Title List and 
ComicBase took you to 2000 A.D. instead.

Checking List of Titles in Stock will rebuild the list of titles you own. This 
is particularly useful if you’ve added titles, but they’re not ap pear ing when 
you click the Titles in Stock.

Checking Is sue In for ma tion will rebuild val ues with in ComicBase, and 
is par tic u lar ly helpful if you believe ComicBase may be totalling values 
incorrectly. Rebuilding issue information will also check through your 
notes, storylines, writer, and artist lists and will remove any duplicate 
or near-duplicate information (e.g. a note reading “1st ap pear ance of 
Punisher; 1st appearance of The Punisher”). In dis card ing duplicates, in 
this manner, the longest item will be preserved. In the example above, the 
note would be changed to “1st appearance of The Punisher”. This option 
also standardizes the spellings of thousands of known creator names.

Checking Find Comics Lists will rebuild the Find Com ics lists which appear 
after you’ve used the Find com mand to fi nd char ac ter ap pear anc es, work 
by a writ er, or other comic book related information. If the lists that are 
ap pear ing are in ac cu rate, check off this box.

RESET COMICBASE SETTINGS

If at any time you want to reset the your preferences in ComicBase, simply 
go to File Tools and hit the Reset ComicBase Preferences. This command 
is useful for returning ComicBase to its “factory set tings.” If you’ve added 
grades, publishers, issue variations, or made other special modifi cations 
to ComicBase, it will remove them and replace them with the original 
settings. However, it will not remove any collection data, such as issues 
owned, from your copy of ComicBase.

REMOVE EXTRANEOUS NM ISSUES

When you enter an issue that’s not in Near Mint con di tion, ComicBase 
creates a listing for it and leaves a listing for the same issue in NM 
condition. If you’d like to re move these extraneous issues, click the Remove 
Ex tra ne ous NM Issues button. When you do so, ComicBase removes any 
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issues in NM condition for which there is a quantity of 0 and for which 
there are issues listed in a non-NM condition.

CURRENCY CONVERSION

The Convert Cur ren cies button converts the values in ComicBase, which 
are in U.S. dollars, to your local currency values.

You’ll need to know the current exchange rate from U.S. dollars to your 
local cur ren cy. When you click the button, a window like the following 
ap pears. 

Type in how much 1 U.S. dollar would be worth in your cur ren cy (i.e. 1.5 
Canadian dollars, .68 UK pounds) and click OK to convert the values.

REMOVE MATURE READER TITLES

ComicBase covers the entire world of comics, in clud ing a number of titles 
designated for mature readers only. These may have been classifi ed as such 
due to sexual content, graphic vi o lence, and/or de pic tions of drug use

If you don’t want to view such titles—or don’t want the person who 
will be using ComicBase to view such titles, you can remove them from 
ComicBase. To do this, select the File menu and go to File Tools. In the 
box that appears, click Remove Mature Titles.

Once removed, a title can only be restored by reinstalling ComicBase or by 
manually adding the title back into the database.
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BUYING & RESEARCHING 
YOUR COMICS ONLINE

ComicBase connects you directly to online auction services with the 
Buy command under the Internet menu. You can use the Internet menu’s 
Buy command to automatically look for an issue online, or research past 
pricing on a given issue.

The Setup menu’s Buying command lets you set up ComicBase to connect 
to the online auction service of your choice.

The Preferred Buying Service menu lets you select the auction service you 
want to use for buying comics. This is the service to which ComicBase will 
connect to locate an issue you want to buy.

You can use the Buy command to help locate those hard-to-find issues on 
the major internet online auction sites. 

To search for an issue on an online auction service, click on the issue in the 
Issues view to highlight it. Select the Internet menu’s Buy command and 
ComicBase will show you all auctions on your preferred auction service 
that may have the issue you’re looking for.

You can also check for all issues of a given title by choosing the Buy 
command without highlighting a specific issue. 

If you hold down the shift key on your keyboard when choosing the Buy 
command, ComicBase will search through your auction site’s historical 
pricing archive to find what recent copies of the selected issue have sold 
for. This is a quick way to do your own pricing research and is particularly 
useful for comics which change in value very rapidly.
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TROUBLESHOOTING

Although we hope your experience with ComicBase is blemish-free, we 
have added this section to answer frequently-asked questions, let you 
know how to resolve problems yourself, and give you tips on getting the 
best technical support from us.

PROBLEM SOLVING TIPS
A few simple steps can clear up many common problems. If you’re 
experiencing trouble with ComicBase:

1.  ComicBase is so much fun, you probably installed it and got 
going right away. But if you are having trouble figuring out 
how to use a certain feature, or how to use it more efficiently, 
browse through the user’s guide.

2.  Read the “Read Me” file on the ComicBase disk. This details 
known incompatibilities and other known problems which may 
have come to our attention after this manual was written.

3.  If you have access to the internet, select the Internet menu’s 
Check for Program Updates command, or go to our website, 
http://www.comicbase.com, for more recent updates or 
incompatibilities. If necessary, download the latest update.

4.  Use File Tools to compact ComicBase, rebuild the title list, or 
reset program settings. Information on these features is covered 
in the Advanced ComicBase section.

5.  Try to recreate the problem. This way, when you call, you can 
tell technical support exactly how the problem occurred. Write 
down any error messages that appear.

Before you call technical support, make sure you have the following 
information ready:

•   Which version of ComicBase you have (i.e. version 9.0.1)
•   The operating system you’re running (i.e. Windows 95, Windows 98, 

Windows NT, Windows ME, or Windows XP) and how much memory 
(RAM) your computer has. If you don’t know, right-click on “My 
Computer” and choose Properties to find out.

•   When you call, we will look for you in our registered users database. 
If you haven’t registered your copy of ComicBase, have your serial 
number handy. You can find your serial number on the inside front 
cover of this user guide, on the case or sleeve the ComicBase disk was 
in, and (if you haven’t sent it in) on your registration card.

You can reach technical support by telephone: (408) 266-6883, 
fax: (408) 266-5869, or e-mail: support@human-computing.com. 

Include your name (and if you haven’t registered, your serial number), what 
kind of problem you’re having with ComicBase, a phone number where 
we can reach you, and the best time to reach you, in any messages.

INFORMATION ONLINE

Minor updates and bug fixes 
to the current version of Com-
icBase are free online at 
h t t p : / / w w w. c o m i c b a s e . c o m /
Support/Updaters/ComicBase_
Updates.asp

A complete list of all the titles in the 
current version of ComicBase, re-
ports of incompatibilities, and other 
troubleshooting tips are available at 
h t t p : / / w w w. c o m i c b a s e . c o m /
Support/Technotes/technotes.asp

News and information on 
ComicBase can be found at 
http://www.comicbase.com



COMICBASE 9 USER GUIDE GENERAL TROUBLESHOOTING

48

COMICBASE 9 USER GUIDE GENERAL TROUBLESHOOTING

49

FREQUENTLY ASKED QUESTIONS
This list covers our most frequently-asked support and technical 
questions. You can find more frequently-asked questions online at 
http://www.comicbase.com/Support/FAQ.asp

Q: Why don’t you have (my favorite title) in ComicBase?
A: Hey! We’re trying! But seriously, there are a few major reasons why a 

particular title may not be covered: 1) the title came out too recently 
to make it into the latest edition, 2) the title is old and/or rare and 
therefore difficult for us to obtain for coverage, or 3) the title is still 
in the process of being reviewed, indexed, historically priced, and 
scanned, or 4) the title may be indexed under another name, such as 
Four Color Comics.

     
 If you find ComicBase doesn’t have a title you collect, use the New 

Title command to add titles from your collection into ComicBase. 
If the title appears in the next ComicBase update, you can easily 
integrate any information you’ve added into the update process.

Q: Where are the rest of the X-Men (or Justice Leagues, or…)?
A: Marvel’s X-Men are listed as X-Men (1st series) until issue #142, 

after which they went through a little-noticed name change to 
become officially The Uncanny X-Men (where subsequent issues are 
listed). Justice League America/International/Europe went through 
numerous such mid-title name changes, and issues are listed under 
the appropriate titles (although the shifts still make us dizzy). We 
generally try to smooth such transitions by noting where series are 
continued in the notes of the last issue of the original run, as well 
as where they are continued from in the first issue of the renamed 
series.

Q: ComicBase’s pictures aren’t showing and/or the movies won’t play.
A: Make sure you installed QuickTime from the ComicBase disk to make 

sure you have the most compatible version. Also, if you’re storing 
pictures on your hard disk, make sure the pictures are in the correct 
place (see page 38). Lastly, if you’re having trouble reading pictures 
or movies off the disk, check your CD/DVD-ROM drive. Unlike most 
CD/DVD-ROM programs, ComicBase takes up all the space on the 
disk, and sometimes a failing drive may have trouble reading all the 
way out to the edges of the CD/DVD. 

Q: Windows keeps telling me there isn’t enough space to install 
ComicBase.

A: Windows requires two to three times the amount of your RAM as 
“swap space” on your hard drive, generally the C: drive. Also the C: 
drive is used to decompress files. Even if you’re installing onto a drive 
other than the C: drive, your C: drive will need about 200MB of free 
disk space. You cannot install ComicBase to your A: or B: drives.

Q: I can’t save a backup copy of ComicBase.
 A: You need to make sure you have enough space for a backup. You can 

specify where you want ComicBase to save its backup by clicking the 
Change Location button in the Preferences dialog box.



KEYBOARD SHORTCUTS

CTRL + A SELECT ALL

CTRL + B BUY COMICS

CTRL + SHIFT 
+ B

CHECK HISTORICAL AUCTION PRICES (IF NO COMICS ARE SELECTED, THESE COMMANDS LOOK FOR 
ANY AUCTIONS FOR THE TITLE. IF COMICS ARE SELECTED, ONLY AUCTIONS FOR THAT ISSUE ARE 
SHOWN.)

CTRL + C COPY

CTRL + D DUPLICATE THE SELECTED ISSUE

CTRL + E EDIT TITLE DESCRIPTION

CTRL + F FIND COMICS

CTRL + G QUICK CHANGE THE SELECTED ISSUES

CTRL + H HYPERTEXT (USED WHEN EDITING DESCRIPTIONS)
CTRL + I MODIFY ISSUES

CTRL + SHIFT + I MODIFY ISSUES FOR THE CURRENT TITLE

CTRL + J FIND & REPLACE

CTRL + L NEW TITLE

CTRL + M MASS CHANGE

CTRL + N NEW ISSUE

CTRL + P PRINT REPORTS AND LABELS

CTRL + Q QUIT COMICBASE

CTRL + R MARK THE SELECTED ISSUES

CTRL + T CHOOSE TITLE

CTRL + SHIFT 
+ T

MODIFY THE CURRENT TITLE

CTRL + U UNMARK TITLES

CTRL + V PASTE

CTRL + W CLOSE WINDOW

CTRL + X CUT

CTRL + Z UNDO

, PREVIOUS TITLE

CTRL + , PREVIOUS TITLE WITHOUT PICTURES

. NEXT TITLE

CTRL + . NEXT TITLE WITHOUT PICTURES

F12 COMICBAS STATISTICS

ONE-KEY ISSUE ENTRY

(Available from the Issues View and Modify Issues screen)

0-9 SETS THE QUANTITY FOR THE HIGHLIGHTED ISSUES TO THAT NUMBER

[ENTER] GO TO THE ISSUE DETAIL FOR THE SELECTED ISSUES

+ ADD 1 TO THE SELECTED ISSUES’ QUANTITY

- SUBTRACT 1 FROM THE SELECTED ISSUES’ QUANTITY

CTRL-CLICK (on Next Title or Previous Title buttons) GO TO THE NEXT TITLE WITH NO ISSUES

ALT-CLICK (on Next Title or Previous Title buttons) GO TO THE NEXT TITLE WITH NO TITLE DESCRIPTION

SHIFT-CLICK (on Next Title or Previous Title buttons) GO TO THE NEXT TITLE WITH NO TITLE PICTURE.
CLICK (on the publisher name on the Pictures View) GO TO THAT PUBLISHER’S WEB SITE. (PUBLISHER NAME WILL SHOW AS COLORED 

TEXT IF A WEB SITE IS DEFINED FOR THAT PUBLISHER)
ALT-CLICK (on the publisher name in Pictures View) OPEN THE PUBLISHER PICTURE FOLDER ON YOUR HARD DISK OR CD
ALT-CLICK  (on a cover picture name on the Pictures View) REVEAL THE CHOSEN PICTURE IN THE WINDOWS EXPLORER
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